
SoundWorks User Guide
Introduction

SoundWorks is a general sound processing program that allows NeXT users to record, play, 
edit, and mix CD-quality sounds.  Any sound supported by the NeXT soundkit can be created, 
modified, and archived to disk.

Of central importance is the Recorder window, which contains the standard tape player buttons 
for recording, playing and storing sounds that have been created.  When many sounds are open 
simultaneously the name of each sound is placed in the scrolling SoundList for quick reference.  
Each entry in the list acts like a separate file.  Users may manipulate several files at once simply 
by selecting them from the list and applying a command.  This scheme allows users to quickly 
change sound formats, open, close, save, and play groups of files.  It also keeps the sounds 
organized and at a user's fingertips.  

Each sound may also display an Editor window where sound data may be edited using the 
standard cut, copy, and paste paradigm.  Several digital effects, including envelope and pitch 
adjustment, reverb, echo and delay, may also be applied to the sound.

Once several sounds have been recorded, edited, and polished, users can link sounds together 
to create CD-quality master recordings.  When sounds are linked, they may be mixed into each 
other or attached with a specified gap between the sounds.  Any number of tracks may be 
combined together in this fashion, allowing users to create and save multi-track sounds.  

For more specific information, see the appropriate help selection below:

Create a new sound
To create a new sound, select New from the Sounds menu.  This will create an empty sound in 
the SoundList with recording parameters (length, source, and sampling rate) as shown in the 
Settings panel.

Saving Sounds

To save a newly-created sound, choose one of the standard Save options in the Sounds menu.  
A save panel appears for you to specify the location where the sound will be saved on disk.  You 
may save sounds only to directories where you have write permission.  If you try to close a sound 
which has been edited or modified in any way, or if you try to quit SoundWorks without saving 
changes, an alert panel will appear prompting you to save the changes.

Opening Sounds

To open a sound that has been saved, choose the Open... option from the File menu.  An open 
panel appears where you may locate and select sounds that are to be opened.  Any number of 
sounds may be opened simultaneously.  If a sound cannot be opened for some reason, an alert 
panel appears to notify you of the problem.  When the sounds are opened, they appear after the 
last selection in the list, or at the beginning if no sound was selected.



Play a single sound
To play a single sound, simply select it from the SoundList and press the play button.  To play 
many sounds one after another, select the sounds from the list and press the play button–you 
may shift-click to make multiple, unconnected selections.  The selected sounds appear to stand 
out (like buttons) in the SoundList to indicate they are the sounds intended for playback.

During playback, the status bar and timefield update to reflect the current playing time.  If the 
meters are active, they monitor the playback of the sound.  The sound which is currently playing 
is highlighted in the SoundList.

To stop playback of a sound, either press the stop button or click on another selection in the 
SoundList.  Playback also stops when you create a new file, open files from disk, or save files.  
By selecting the Repeat button, the selected items are repeated until you stop them.

Disk Space

The maximum recording length is a function of available disk space.  The Diskspace Panel 
shows a list of space available on all mounted filesystems.  Each entry in the list displays an icon 
indicating the type of filesystem:  hard disk, optical disk, floppy disk, or network (only if the 
Network domain is selected in the Preferences Panel).  To the right of the icon, the full pathname 
of the filesystem is shown along with the available disk space (in the current units displayed in 
the Setting Panel).

One of the entries in the list also shows an arrow pointing to its icon.  This entry is considered to 
be the "default filesystem" where new recordings are written to.  Before a recording is made, 
SoundWorks checks the default filesystem to ensure that there is enough room for the 
recording–if there is not, an alert panel appears to notify you.  To change the default filesystem, 
simply click on an entry in the list.

You may use the Diskspace Panel to change the default record path (which is "/tmp").  To do so 
simply click on the filesystem that you wish to record into.  A panel will appear asking for the full 
pathname of your desired record path.  Usually you will not need to change the record path since 
all soundfiles recorded into it are only temporary and you can always save files into different 
directories using the Save command.

Editing Sound
The waveform of a sound shows the amplitude variations through time of the sound data.  With 
the sound displayed in this manner, words and music can easily be recognized.  By selecting 
parts of the waveform, specific sections of the sound may be isolated, played, copied, removed 
and pasted into other parts of the sound.  When a stereo sound is displayed, the upper waveform 
represents the left channel data and the lower waveform represents the right channel.

In the lower center of the Editor window are buttons similar to those in the Recorder window.  
The buttons allow you to quickly parse through the sound to locate specific sections for editing.

The Display box in the lower left of the Editor window contains scaling controls to zoom in and 
out of the waveform so that greater or lesser detail of the sound is apparent.  The controls on the 



right change the scale absolutely by zooming in and out by a constant zoom factor.  Those on the 
left control relative scaling:  the magnifier glass zooms in on the selected region in the waveform 
display, the button next to it rescales the sound so that the entire waveform is visible in the 
window, and the percentage textfield allows you to specify a portion of the sound to be displayed.

With these controls it is easy to locate and edit sections of the sound.  Simply use the standard 
Cut, Copy, and Paste commands from the Edit menu to edit chunks of the sound data.  There are 
also Delete, Select All, and Effects commands for easy editing and data manipulation.  Those 
commands that may be applied to sounds in the SoundList also work for sounds in an Editor 
window. 

Each sound has an Edit Window associated with it where the sound may be edited in the 
standard cut, copy, and paste fashion.  To display this window, choose the Edit... command from 
the Tools submenu or click on the Edit button in the Recorder Window.  This applies to any 
number of sounds that may be selected in the SoundList.   You may also display an Edit Window 
by double-clicking on an entry in the SoundList.  For the next few moments, SoundWorks loads 
the sound into the Edit Window.  If you are loading several sounds, you may cancel the loads by 
typing Command-period.

The sound in the Edit Window is a copy of the original.  When a sound is being edited, its title in 
the SoundList is displayed in gray.  If you close the window and the sound has been changed, 
an alert panel will prompt you to save the changes.  A sound must be saved before it can be 
edited.

In addition to the standard cut, copy, and paste operations, there are many effects which may be 
applied to a sound in the Edit Window.  The Paste Special command allows you to easily and 
quickly paste a sound at regular intervals, several times, mixing the sound in the Pasteboard with 
the sound in the Edit Window, fading each pasted sound over a range, or fading the group of 
pastes over a range.

Marking Sounds

During editing, you may wish to mark sections of the sound that correspond to particular words, 
phrases, or music.  You may use the Preferences... command to set whether the marks are 
displayed in the Edit Window.  When they are displayed, they appear in a gray bar above the 
waveform view.  Normally, marks are drawn with a light gray background.  The background turns 
white when you edit a mark.

The simplest way to mark a sound is to select the appropriate region in the waveform and begin 
typing.  A textfield is created and displayed just above the selected region, and the characters 
you type on the keyboard appear in the text.  When you are finished marking the region, press 
the Return key.  When you click the mouse on a mark, the region in the sound that the mark 
represents is selected and the selection fields update to reflect the new selection.

When you click on a mark in the Edit Window, the region in the sound corresponding to the mark 
is selected.  If you want to edit a mark, press the Control key before clicking the mouse on the 
text.  You can drag the mouse through the mark to select words or characters, or to extend the 
selection.  To remove a mark, simply delete the text and press the Return key.



The Mark Panel

Each Edit Window has a Mark Panel which summarizes the marks in the window.  To display the 
Mark Panel, click the Marks... button in the lower right corner of the Edit Window.  The Mark 
Panel contains a MarkList showing the names, end points, and sizes of all marks--it is analogous 
to the SoundList in the Recorder Window. 

You may use the buttons in the Mark Panel to add, remove, and edit marks.  The buttons apply to 
the selected mark that correspond to the row in the MarkList where the text is currently being 
edited.  Clicking the Add button adds a new mark to the sound, with the size and endpoints set to 
the currently selected region of the sound.  The Name field in the MarkList is selected so that 
characters that you type on the keyboard appear for the new mark.  When you click the Replace 
button, the endpoints and size of the selected mark is replaced by the selected region of the 
sound in the Edit Window.  The Remove button will remove the currently selected mark from the 
sound.  The Show button selects the region in the waveform view corresponding to the selected 
mark in the MarkList, scrolling the waveform view so that the mark is visible within the Edit 
Window.  The Empty button removes all marks from the sound.

You can use the Mark Panel to type in specific values for marks in the sound.  You may specify 
values for the name, start and stop points, and the size of the mark.  You may use the Tab key to 
jump between cells in the MarkList.

Mixing
You may mix any number of sounds together, two at a time.  When you mix more than two 
sounds, the first two are mixed together, the result is then mixed with the third selection, the result 
from that mixed with the fourth selection, and so on until all the selected sounds are mixed 
together.

To mix sounds, first select the sounds from the SoundList that you want to mix together (make 
sure that they all share the same format).  Then click the Mix... button in the Recorder Window (or 
select the Mix... command from the Tools submenu).  The Mix Panel will appear.

The sliding waveforms allow you to position the sound along the horizontal (time) scale at the 
exact location that you want that sound to be mixed.  Simply click the mouse on the waveform 
and drag the sound to the desired location.

The envelope superimposed on top of each waveform shows how the amplitude changes 
through time when the sound is mixed.  As with the Effects Panel, the shape of the envelope is 
determined by the rectangular "handles" composing the envelope.  The currently selected handle 
is displayed as a bordered white rectangle; all other handles are filled black rectangles.  You 
may change the shape of the envelope by moving, adding, or removing the handles.

The amplitude sliders and fields on the right of each waveform are used to set the overall 
amplitude (in percent) for the corresponding sound.  When you modify a sound's envelope, the 
values for each "handle" in the envelope range between 0 and the the value in the amplitude 
field.

The Result box shows information for the sound which would result if you were to mix the sounds 
with the current parameters. The Size field shows the size (in megabytes) of the resulting sound, 
and the Minutes and Seconds fields show the length. The radio buttons indicates whether the 



sounds are overlapped or if they are separated by a gap, and the field just to the right shows the 
exact length (in seconds) of the gap/overlapped region.

The sound buttons below the sliding waveforms are used to play and parse through a sound.  
The sound to which these buttons apply corresponds to the highlighted selection button above 
the sliding waveforms.  By choosing the RESULT sound, you can preview the mix.  When the mix 
is satisfactory, press the Mix button.  If necessary, the mix is calculated.  The resulting sound is 
then written to disk and added to the SoundList.

Special Effects
SoundWorks provides several effects which can be applied to any sound in an Edit Window.  To 
apply an effect, select the portion of the sound that you wish to apply the effect to, then choose 
one of the following commands from the Effects menu.

Effects Panel

This command displays the Effects Panel.  The Amplitude, Pitch, Echo and Reverb effects are all 
accessed through this panel.  This panel allows you to apply several of these effects at once and 
to preview how they will change the sound.

The waveform of the selected region of the sound will appear in the Effects Panel.  
Superimposed over the waveform is an envelope.  This envelope allows you to specify how you 
want either the amplitude or the pitch of the sound to change.  If you want to change the 
amplitude, click on the Amplitude/Pitch button until it reads Amplitude.  If you want to change the 
pitch, click on the button until it reads Pitch.  You cannot change both the amplitude and pitch at 
the same time.

The envelope can be manipulated in the same way whether you are changing the amplitude or 
pitch.  The difference is in the vertical scale.  When you are changing the amplitude, the vertical 
axis represents the relative amplitude of the sound.  When you are changing the pitch, the 
vertical axis represents octaves of pitch shifting; the envelope can be adjusted to both positive 
and negative values corresponding to raising or lowering of pitch.  In either case, the vertical 
scale may be changed with the popup Scale button below the waveform.

You may change the shape of the envelope by moving, adding, or removing the handles.  To 
move a handle, click the mouse on the handle and drag it wherever you want on the waveform.  
The endpoints of the envelope may be moved vertically, but not horizontally.  To add a new 
handle, click anywhere in the waveform that is not on a handle. A new handle is created at the 
current mouse location.  To remove the selected handle, press Command-x on the keyboard 
(Cut).  The envelope is redrawn to reflect the removal.  You may not remove the handles at the 
endpoints.

Remember that if you increase the amplitude of a sound too much, you will cause the sound to 
clip.  Also excessive pitch shifting can result in obvious aliasing.  If you get aliasing in a sound, 
you are increasing the pitch too much--try to avoid it.  Try filtering out the higher frequencies 
before you change the pitch.

In addition to allowing you to change the amplitude or pitch of a sound, the Effects Panel lets 
you simultaneously add reverb and/or echoes to the sound.  These effects are actually performed 
after the amplitude or pitch changes are applied.  If you are adding both echoes and reverb, the 



echoes are added before the reverb is.

Echo or reverb will be added to the sound whenever their respective boxes are highlighted.  To 
highlight (or unhighlight) a box, simply click on or inside the box (but not inside the text fields) as 
if it were a button.

When the Echo box is highlighted, echoes will be added to the sound according to the 
parameters specified in the Echo box.  The echo delay is the time delay between each echo.  
The echo strength is the percent that each echo is of the last.  For example, with an echo strength 
of 50%, the first echo will be 50% of the original region, the second echo will be 50% of the last 
echo, or 25% of the original segment, and so on.  You can set the number of echoes in the last 
textfield--this does not include the original sound.

Each echo is added to the original sound.  Consequently, you should be aware of the number of 
echoes within a given segment as well as the strength of each echo.  If too many echoes are 
added to the sound, it can become loud very quickly, and it may distort.

Since an echo implicitly continues past the end of a sound, if you want the echo to die out 
gradually, be sure there is some blank space at the end of the selected region so that the echoes 
will fade into silence.  The Blank... command described is useful for this purpose.

When the Reverb box is highlighted, reverb will be added to the sound.  There is one parameter, 
reverb time, that needs to be set.  The longer the reverb time is, the higher the ratio of reverberant 
to original sound will be.  If the reverb time is set too high, unnatural sounds or clipping may 
occur.

The buttons beneath the waveform operate just like those in the Edit Window.  You can use the 
buttons to pay and parse through a sound to.  The sounds to which these buttons apply 
corresponds to the highlighted selection button in the upper left hand corner of the Effects Panel.  
The button on the left refers to the original sound without effects, while the RESULT button on the 
right refers to the result after applying the specified effects to the original sound.  If you have 
changed one or more of the effects parameters, the sound is modified accordingly before it is 
played back.  This allows you to hear what each particular setting will sound like before actually 
applying it to the sound.

Once all of the effects are set just the way you want them, click on the Apply button.  After the 
sound has been modified, it is redrawn in the Edit Window and the Effects Panel is removed 
from the screen.

Blank

This command adds a blank region to the sound.  After choosing this command, a panel appears 
for you to specify the length of the blank.  If there is a current selection, the default value of the 
blank will be the same length as the selection.  Type in the length of the blank region and click 
the Apply button.  SoundWorks replaces the selected portion with blank data of the specified 
length, or adds a blank segment if there was no selected region in the sound.

Filter

This command allows you to filter the sound by bringing up a Filter Panel which resembles a 
graphic equalizer.  Each of the sliders represents a particular frequency range.  By lowering or 
raising a particular slider, you set the amount by which the corresponding frequency component 



is decreased or increased.

Each slider can be set to values between -15 dB (decibels) and +15 dB.  The sliders are initially 
set to 0 dB, which does not increase or decrease the corresponding frequency.  You may reset 
the sliders to their default 0 dB values with the Reset button.

For sounds recorded with a sampling rate of 44.1 kHz, all of the sliders may be used.  For lower 
sampling rates, certain higher-frequency sliders are deactivated because those components are 
not present in the sound. 

Filtering of sounds takes a very long time to perform.  The more sliders that you change and the 
longer the sound is, the longer the operation takes to complete.  For this reason, you should 
modify only a few sliders at a time and listen to the difference.  To apply the selected filter to the 
sound, click the Apply button.

Reverse

To reverse a sound, choose this command from the Effects menu.

Resolution and sampling rate of a sound

The format of a sound determines both the resolution and sampling rate of a sound.  Sampling 
rate refers to the frequency that the sound is sampled at while resolution refers to the number of 
bits used to represent each sample frame of the data.  A higher sampling rate and a higher bit 
resolution both increase the dynamic range of the recording and give a truer reproduction of the 
sound, but they also take up much more disk space.

8-bit Mulaw is a standardized logarithmic scale useful in compressing dynamic range.  The 
numbers representing possible16-bit amplitude values are replaced by a logarithmic 
approximation of those numbers, stored as a number from 0 to128.  This sound data is 
uncompressed by the DSP as it is played back over the NeXT.  The advantages of this format is 
that is takes up relatively little storage space and is easy to manipulate rapidly.  Mulaw data is 
initially recorded from the built in NeXT CODEC input on the back of the MegaPixel display.  

With16-bit Linear sounds, the amplitude value of the data is stored as a 16-bit value (from -32767 
to +32768) stored as left, right, left, right in stereo and left, left, left, left in mono mode.  The audio 
input device samples the sound on two channels and sends this data to the NeXT DSP port.

To change the format of a sound, select it in the SoundList and choose the Change Format... 
option from the Sounds menu.  A Sound Format panel appears with all the available format 
options for the selected sound.  If many sounds are selected, clicking the Change All button in 
the panel will change all remaining selections to the current format shown in the panel.  If a 
sound cannot be changed, an alert will notify you of the difficulty.

The Settings Panel allows users to specify the length, source, and sampling rate for recording.  
By selecting the Set to Maximum switch, the sound is always set to the maximum allowable 
length.  Currently, the recording may be done at one of the following formats :

• 8 kHz mono from the CODEC microphone
• 22.05 kHz (stereo or mono) from the NeXT DSP port



• 44.1 kHz (stereo or mono) from the DSP.

Owners of the Digital Ears Audio Input Device from Metaresearch may also record data at 88.2 
kHz mono from the DSP port (See the Digital Ears User Manual for details), while owners of the 
Digital Microphone from Ariel may record data at 11 kHz and 5.5 kHz.  You should indicate which 
input device you are using by selecting the proper selection in the Preferences panel.

When using Digital Ears, recording at 22.05 kHz stereo is done simply by discarding every other 
data point--no special filtering is done.  For some sounds that contain very high frequencies, you 
may wish to record at 44.1 kHz, then convert to 22.05 kHz using the Change Format... menu 
option.

Mono recordings can be made by averaging the left and right channels of the stereo input or by 
using only the left or only the right channel information.

For more information on sound formats, see the discussion in the NeXT Technical 
Documentation, Chapter 10. 

Recording
The Recorder window acts like a digital tape deck with buttons equivalent to the standard play, 
stop, record, fast forward, etc. functions.  Users may pause sounds, rewind or fast-forward 
through them, or skip between selections.  The SoundList keeps track of all currently open 
sounds and is organized so that commands and options may be applied to many sounds 
simultaneously.  By clicking on an entry, pertinent information (size, sampling rate, time length, 
etc.) for the selected sound is displayed to the left of the list.  By shift-clicking on several entries, 
multiple sounds can be selected so that options and commands are applied to those files 
simultaneously.

The Record Settings panel allows users to specify the length, source, and sampling rate for a 
recording.  By selecting the Set to Maximum switch, the sound is always set to the maximum 
allowable length.  This maximum recording length is displayed in the Diskspace panel along 
with a list of available diskspace on all other active filesystems, including optical disks.  Use the 
Preferences panel to include local or networked filesystems.

Before recording, ensure that the Record Settings panel reflects the appropriate length, source, 
and sampling rate for the recording.  

The virtual VU Meters may be used to set input levels and to monitor recording and playback of 
sounds.  The meter levels show the relative rms strength of the signal from -60 to +6 dB.  

If you will record from the DSP, first play part of the sound passage that you wish to record.  For 
best results, play the loudest part of the passage.  Then adjust the input knobs on the Digital Ears 
until the meters read between -2 and 0 dB.  If the signal is clipped, the Left and/or Right name 
fields below the meters light up in white.

CODEC recording levels may not be set by the user.  However, you may wish to use the Monitor 
to experiment with various volumes and distances from the recording microphone.  During 
recording and playback of CODEC sounds, both meters indicate the level of the single CODEC 



channel.

Press the record button.  The NeXT computer now sets up for recording, loading any necessary 
DSP code, highlighting buttons, etc.  When everything is set up properly, the pause button lights 
up.  You are now ready to record.

The sound should be prepared to record as described in "Preparing" under "Creating Sounds."  
To begin the actual recording, press the (lit) pause button.  The status bar and timefield beneath 
the sound information begin to animate, reflecting the current recording time.  To stop recording 
before the maximum length has elapsed, press the stop button.  

To pause during recording, simply press the pause button.  Both the status bar and the timefield 
stop animating.  If the meters are active, they continue to reflect the strength of the incoming 
signal.  To resume recording, press the pause button again.

The recording continues until the maximum recording length has elapsed or until the stop button 
is pressed.  The NeXT then resets the DSP for monitoring and activates all appropriate buttons 
and meters.

Note:  Before recording from the DSP make sure to connect the proper audio input device (such 
as Digital Ears from Metaresearch or Ariel's Digital Microphone) to the DSP port on the back of 
the NeXT Computer.  After connecting the device, use the Preferences panel to indicate  to 
SoundWorks which device you are using.

The Recorder window acts like a digital tape deck with buttons equivalent to the standard play, 
stop, record, fast forward, etc. functions.  Users may pause sounds, rewind or fast-forward 
through them, or skip between selections.  

The SoundList keeps track of all currently open sounds and is organized so that commands and 
options may be applied to many sounds simultaneously.  By clicking on an entry, pertinent 
information (size, sampling rate, time length, etc.) for the selected sound is displayed to the left of 
the list.  By shift-clicking on several entries, multiple sounds can be selected so that options and 
commands are applied to those files simultaneously.  Double-clicking on an entry opens an Edit 
Window for that sound.

When sounds are created or opened they are placed in the list immediately after the current 
selection.  If there is no selection, the sounds are placed at the beginning of the list.  Any time a 
new selection is made from the list, any playback or recording is interrupted and the sound 
information for the newly selected sound is displayed.

To reorder sounds in the list, hold down the Control key and click (but do not release) the mouse 
button on a selection in the list.  As the mouse is dragged through the list, the selection moves 
along with it.  Release the mouse button and the original selection will be inserted at the 
specified location in the list.

The Monitor allow users to monitor incoming sound in order to set recording levels.

Pasting
In addition to the normal Paste command, SoundWorks provides the Paste Special... command 



for unusual pastes.  After choosing the Paste Special... command from the Edit menu, 
SoundWorks displays the Paste Panel.  The Paste Panel allows you to paste the sound from the 
pasteboard in many different ways.

Inserting or Mixing the Paste

If the Insert into sound radio button is selected, the paste sound is inserted at the current cursor 
location, replacing any selected region of the original sound.  If the Mix into sound button is 
selected, the paste sound is mixed into the selected region.  If the selected region is not large 
enough to hold the entire paste sound, a blank space is added to make the selection just the right 
size.

Pasting Several Times

To paste several times, first select the radio button in the Paste Panel corresponding to the way 
that you want to paste.  If you want to paste at regular intervals, type in the interval over which the 
sound will be pasted.  If you want to paste several times, type in the number of pastes that you 
want to perform.  Whenever you choose one of these buttons, the relevant textfield is enabled 
and selected.  Whenever you paste several times, the paste occurs over the selected region of 
the sound in the Edit Window.

Specifying the Envelope for the Pasted Sound

The envelope in the Paste Panel is used the same way as that in the Effects Panel.  With it, you 
may move, add, or remove "handles" that specify the amplitude envelope for the pasted sound.  
The envelope is applied to the pasted sound each time before it is pasted.  You may type 
Command-x to cut a handle from the envelope.

Specifying fades over a group of sounds

Whenever you paste a sound more than once, the fields to the right of the envelope are used to 
determine the master gain for the sound in the Pasteboard each time it is pasted.  If you paste 
ten times, for example, the first paste will be at the value specified by the value in the First Paste 
field, the last paste will be at the value in the Last Paste field, and all other pastes in between will 
be at some intermediate value, corresponding to how many pastes have been done so far.  If you 
set the first and last pastes at 10% and 100% respectively, the second paste would be at 20%, 
the third at 30%, the fourth at 40%, and so on.

Command Key Equivalents
Any window or panel that displays the array of sound control buttons (play, stop, pause, etc.) has 
access to Command key equivalents for those buttons.  They operate just like menu Command 
key equivalents.  They will apply to whichever window is the main window if that window can 
respond.  The following table lists the keys and their corresponding functions:

Key Function



'p' Play
'[' Stop
']' Pause
'\' Record (if applicable)
'-' Rewind
'=' Fast Forward

General Preferences

The Preferences Panel allows you to set your preferences for several different parameters.  To 
view the Preferences Panel, select the Preferences... command from the Info menu.  To change 
the preferences, select the desired options and then click on the Set button or press the Return 
key.  The changes will take place immediately and will apply to all appropriate windows and 
panels.

Before using SoundWorks you should register which audio input device you will be using by 
selecting the appropriate choice under Input Device.  Currently, SoundWorks supports two input 
devices: Digital Ears from Metaresearch, Incorporated and the DM-N Digital Microphone from 
Ariel Corporation.

In the Units box are two radio buttons for selecting how you wish the time units to be displayed.  
Units may be displayed in minutes and seconds or samples.  

In the Domain box, there are switches for selecting which filesystems will be displayed in the 
Diskspace Panel.  The local filesystems will always be displayed, but you can choose to have all 
mounted network filesystems displayed also.  You should choose this option only if you plan to 
record over a network for it will slow down the response of the Diskspace Panel as it checks the 
available space on all the network filesystems.  If you choose to preserve the record path that you 
entered when you changed the default record path, then that new path will become the default 
path the next time you reboot SoundWorks.

Editing Preferences

The Preferences Panel allows you to select the dimensions and location of the next Edit 
Window.  You can either type in the screen coordinates where you wish the window to appear, or 
you can click on the Current button to have the window appear where the current main Edit 
Window is.  If the Stack switch is on, the Edit Windows will come up one stacked above another 
as opposed to one overlapping another.  This will take up more screen space but will allow you 
to see each Edit Window in its entirety when it first appears on the screen.

If the Mark option is selected, marks will be displayed above the waveform in each Edit Window.  
If the Grid option is selected, a uniform grid of vertical lines will be superimposed over the 
waveform to ease locating and selecting regions of sound.

The Zoom field allows you to enter the amount by which the Zoom in button will enlarge the 
waveform.  When you Zoom out, the waveform will shrink by a corresponding amount.



User Notes for SoundWorks Release 2.0
1. The meters are slower to respond when a sound is being played or recorded.

2. During recording, avoid using the mouse except to stop or pause the recording.

3. When using Metaresearch Inc.'s Digital Ears input device, recording at 22.05 kHz is 
done simply by discarding every other data point—no special filtering is done.  For some 
sounds that contain very high frequencies, you may wish to record at 44.1 kHz, then convert 
to 22.05 kHz using the Change Format... menu option.

4. While SoundWorks supports recording at 5.5 kHz and 11 kHz when using Ariel 
Corporation's Digital Microphone and 88.2 kHz mono when using Metaresearch Inc.'s 
Digital Ears, playback at these rates is not supported yet.

5. The Diskspace Panel does not currently support displaying network filesystems.  If you 
would like to record into a directory on a network filesystem, click on the row containing your 
current system disk and then enter the full UNIX pathname of the directory into which you 
would like to record.  Make sure that the filesystem has already been mounted before trying 
to record onto it.


